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1. 重要

1. 重要

此电子版用户指南适合使用 Philips 显示器的
所有用户。 请在使用您的显示器之前花点时
间阅读本用户手册。 它包含与使用显示器相
关的重要信息和注意事项。

产品享受飞利浦保修须符合下列条件：产品
适当用于其设计目的、符合操作说明、返修
时提供原始帐单或付款收据，帐单或收据应
载明购货日期、销售商名称、产品型号及生
产号。

1.1 安全措施与维修

 警告

使用本文档中未介绍的控制、调整或过程可
能导致碰撞、电气危险和 / 或机械危险。
连接和使用电脑显示器时，请阅读并遵循以
下说明。

操作：
• 不要让显示器受阳光直接照射，并使其远

离火炉或其它任何热源。
• 移开任何可能掉入通风孔的物品或者会妨

碍显示器电子器件正常冷却的物品。 
• 不要堵塞机壳上的通风孔。
• 放置显示器时，确保电源插头和插座便于

插拔。
• 如果通过拔掉电源线或直流电源线关闭显

示器电源，则在重新连接电源线或直流电
源线以进行正常操作之前，必须等待 6 秒
钟。

• 请务必使用由 Philips 提供的经过认可的电
源线。如果电源线缺失，请与您当地的服
务中心联系。（请参见“消费者信息中
心”）

• 在使用过程中，请勿让显示器受到剧烈震
动或碰撞。

• 在使用或运输期间，不要敲打显示器或使
显示器掉落。

维护
• 为保护显示器以避免可能的损坏，请勿过

分施力于LCD面板。移动显示器时，抓住
边框将其抬起；抬起时，不要将手或手指
放在LCD面板上。

• 长时间不使用显示器时，应拔掉显示器电
源插头。

• 使用略微蘸湿的布清洁显示器时，应拔掉
显示器电源线插头。电源关闭时，可以
使用干布擦拭屏幕。但是，切勿使用有机
溶剂（如酒精）或含氨水的液体清洁显示
器。

• 为避免电击或本机永久性损坏，不要在多
尘、下雨、水附近或过分潮湿的环境中使
用显示器。

• 如果显示器被弄湿了，应尽快用软布擦拭
干净。 

• 如果异物或水进入显示器，请立即关闭电
源，并拔掉电源线。然后，取出异物或擦
干水，并送到维修中心进行检修。

• 请勿在炎热、阳光直接照射或严寒的地方
存放或使用显示器。

• 为了保持显示器的最佳性能并延长使用寿
命，请在符合下列温度和湿度条件的地方
使用显示器。

 o 温度：0-40˚C 32-95˚F
 o 湿度：20-80% RH
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1. 重要

• 重要：显示器无人看管时务必启动移动的
屏幕保护程序。如果显示器将显示静止不
变的内容，请务必启用屏幕定期刷新应用
程序。长时间不间断显示静止或静态图像
可能会在屏幕上造成“烙印”，也称“残
像”或“余像”。
“烙印”、“残像”或“余像”是LCD面
板技术的一种常见现象。多数情况下，关
掉电源一定时间后，“烙印”、“残像”
或“余像”会逐渐消失。

 小心
严重的“烙印”、“残像”或“余像”不会
消失，不能修复。上面提到的损坏不在保修
范围内。

维修
• 只有专业的维修人士可以打开机壳盖。
• 如果在维修或集成时需要任何文档，请与

您当地的服务中心联系。（请参见“消费
者信息中心”一章）

• 关于运输信息，请参见“技术规格”。
• 不要将显示器放在阳光直接照射的车内。

 注
如果显示器工作不正常，或者当您参照本手
册中的操作说明而不知道应执行哪个步骤时，
请与服务技术人员联系。

1.2 标志说明 

以下分节描述使用于此文件的标志惯例。
注、注意、小心
在此指南中，文字段落配有图标并以黑体或
斜体书写。这些段落含有注、注意或小心字
句。其使用如下：

 注
此图标显示重要信息和提示，以助你更好地
使用你 的电脑系统。

 注意
此图标显示的信息提醒你如何避免硬体的潜
在损害或 数据丢失。

 小心
此图标显示对身体伤害的可能性，并警告你
如何避免 此问题。
某些小心警告可能以不同格式出现，也可能
不带任何图标。在此类情况下，小心警告的
具体显示由管理机关规定。
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1. 重要

1.3 产品和包装材料的废弃

废旧电气和电子设备 - WEEE

This marking on the product or on its packaging 
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic 
appliances, this product may not be disposed 
of with normal household waste. You are 
responsible for disposal of this equipment through 
a designated waste electrical and electronic 
equipment collection. To determine the locations 
for dropping off such waste electrical and 
electronic, contact your local government office, 
the waste disposal organization that serves your 
household or the store at which you purchased 
the product.
Your new monitor contains materials that can be 
recycled and reused. Specialized companies can 
recycle your product to increase the amount of 
reusable materials and to minimize the amount to 
be disposed of. 
All redundant packing material has been omitted. 
We have done our utmost to make the packaging 
easily separable into mono materials.

Please find out about the local regulations on how 
to dispose of your old monitor and packing from 
your sales representative. 

Recycling Information for Customers
Your display is manufactured with high quality 
materials and components which can be recycled 
and reused.
To learn more about our recycling program please 
visit www.philips.com/about/sustainability/recycling.
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2. 设置显示器

2. 设置显示器

2.1 安装

273E3L/273E3LH
 包装箱内物品

Register your product and get support at

www.philips.com/welcome
273E3L

Quick

Start

VGA (optional) DVI (optional)

2011 Koninklijke Philips Electronics, N
.V. All rights reserved. Unauthorized duplication is a violation of applicable laws. M
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Monitor drivers

Quick Start Guide
SmartControl software

Audio cable (optional)   DVI（选件） VGA（选件） 音频线（选件）

 安装底座支撑臂

273E3L/273E3LH

1.	 将显示器正面朝下放在平滑柔软的表面
上，注意不要刮擦或损坏屏幕。

2.	 用双手拿住显示器底座支撑臂，用力将
底座支撑臂插入底座支撑柱。
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2. 设置显示器

 连接电脑

5

5

6 6

 交流电源输入

 VGA 输入

 DVI-D 输入（仅适用于特定型号）

 Kensington 防盗锁

 HDMI 输入（仅适用于特定型号）

 音频输入（仅适用于特定型号）

连接到 PC

1.	 将连接线牢固连接到显示器背面插
口。

2.	 先关闭电脑，再拉出电源线。
3.	 将显示器讯号线连在电脑背面的视听

连接器。
4.	 将电脑及显示器的电源线插入最接近

的插座内。
5.	 打开计算机和显示器的电源。如果显

示器显示图像，则安装完毕。

2.2 操作显示器

273E3L

273E3LH

8

 产品正面说明

：访问 OSD 菜单。

：返回上一级 OSD。

：切换至 4:3 显示。

：打开和关闭显示器的电源。

：调整 OSD 菜单。

：切换信号输入源。

： SmartImage Lite。有 3 种模式
供选择：Standard（标准）、
Internet、和 Game（游戏）。

! ：调整显示器音量。
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2. 设置显示器

 屏幕显示（OSD）说明

什么是屏幕显示（OSD）?

屏幕显示（On-Screen Display，OSD）是所有 
Philips LCD 都具有的特性。它使得最终用户可
以通过屏幕说明窗口直接调整屏幕性能或选
择显示器功能。用户友好的屏幕显示界面如
下所示：












 

控制键简介

在上面显示的 OSD 中，用户可以按显示器前
面板上的   按钮移动光标，按 OK（确定）
所作的选择或更改。

OSD 菜单

下面是 OSD 结构概览。以后进行各种调整
时，可以以此作为参考。

Main menu Sub menu

Input
VGA

DVI (available for selective models)

Picture
Wide screen,4:3

0~100

0~100

On, O�

Picture Format

Brightness

Contrast

SmartContrast

OSD Settings

0~100

0~100

O�, 1, 2, 3, 4

5, 10, 20, 30, 60

Horizontal

Vertical

Transparency

OSD Time out

Setup

0~100

On, O�

Yes, No

0~100

0~100

0~100

H. Position

Auto

V. Position

Phase

Clock

Resolution Noti�cation

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский  简体中文,Türkçe 

Color
6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temp.

sRGB

User De�ne

273E3L

Main menu Sub menu

Input
VGA

DVI

HDMI

Picture
Wide Screen,4:3

0~100

0~100

On, O�

On, O�

Picture Format

Brightness

Contrast

SmartResponse

On, O�

SmartContrast

OSD Settings

0~100

0~100

O�, 1, 2, 3, 4

5, 10, 20, 30, 60

Horizontal

Vertical

Transparency

OSD Time out

Setup

0~100

On, O�

Yes, No

0~100

0~100

On, O� 

0~100

H. Position

Over Scan

Auto

V. Position

Phase

Clock

Resolution Noti�cation

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский  简体中文,Türkçe 

Audio
Mute

Color
6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temp.

sRGB

User De�ne

273E3LH

On, O�Stand-Alone
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2. 设置显示器

 分辨率通知

根据设计，此显示器在固有分辨率 
1920×1080@60Hz 时达到最佳性能。当显示器
以不同的分辨率开机时，屏幕上会显示提醒。
为达到最佳效果，请使用 1920×1080@60Hz。
如果要关闭原始分辨率提示讯息，请在屏幕显
示选单的 Setup（设定）中进行设定。

 物理功能

倾斜

2.3 卸下底座支撑臂和底座

 卸下底座支撑臂
在开始拆卸显示器底座前，请遵循下面的说
明以避免损坏或伤害。

1.  将显示器正面朝下放在平滑的表面上，注
意不要刮擦或损坏屏幕。

2.  按锁定夹，从底座支撑柱上卸下底座支撑
臂。
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2. 设置显示器

 卸下底座

条件：

• 适合 VESA 标准装配情况

1. 取下 3 个螺丝盖。

2.  拧下 3 个螺丝，然后从显示器上卸下底座。

	 注
此显示器可使用 100mm x 100mm VESA-标准
的装配接口。

100mm

100mm
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3. 图像优化

 如何启用 SmartImage Lite ？

1.	 按  在屏幕上启动 SmartImage Lite
2.	 按住  切换Standard（标准）、

Internet、Game（游戏）。
3.	 SmartImage Lite OSD 在屏幕上保留 5 秒

钟，您也可以按“OK”（确定）进行确
认。

4.	 当启用 SmartImage Lite 时，会自动禁
用 sRGB 方案。如要使用 sRGB，您需
要使用显示器前面板上的  按钮禁用 
SmartImage Lite。

除了使用  键向下滚动外，还可以按   按
钮进行选择，然后按“OK”（确定）确认所
作的选择并关闭 SmartImage OSD。
有 3 种模式供选择：Standard（标准），
Internet，Game（游戏）。

3. 图像优化

3.1 Smartimage Lite

 这是什么？

SmartImage Lite 提供一些针对不同内容类型进
行优化的预设值，可以动态地实时调整亮度、
对比度、颜色和清晰度。无论您是使用文字
应用程序、显示图像还是观看视频，Philips 
SmartImage Lite 都能提供非常出色的显示效
果。 

 为什么需要它？

您希望显示器在显示您喜欢的各种类型的内
容时都能提供出色的显示效果，SmartImage 
Lite 软件能够动态地实时调整亮度、对比度、
颜色和清晰度，从而改善您的显示器观看体
验。

 它如何工作？

SmartImage Lite 是 Philips 独有的一项先进技
术，可以分析屏幕上显示的内容。根据您选
择的方案，SmartImage Lite 动态增强图像的对
比度、颜色饱和度和清晰度以增强显示内容
的效果 - 所有这一切只需按一下按钮，全部实
时进行。 
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3. 图像优化

3.2 SmartContrast

 这是什么？

一项独特的技术，可以动态分析所显示的内
容并自动优化 LCD 显示器的对比度以达到最
佳清晰度和观看舒适度，对于清晰、锐利和
明亮的图像提高背光亮度，对于深色背景的
图像降低背光亮度。 

 为什么需要它？

您希望在显示各种内容时都能达到最佳的清
晰度和观看舒适度。SmartContrast 动态控制
对比度并调整背光，以提供清晰、锐利、明
亮的游戏和视频图像或者清晰可读的办公文
字。通过降低显示器的功耗，可以节省能耗
成本，延长显示器的使用寿命。 

 它如何工作？

启用 SmartContrast 时，它将实时分析显示的
内容以调整颜色和控制背光亮度。当观看视
频或玩游戏时，此功能可动态增强对比度，
以达到美好的娱乐体验。

• Standard（标准）：增强文字并降低亮度，
从而提高可读性，减轻眼睛疲劳。当使
用电子表格、PDF 文件、扫描文档或其
他常用办公应用程序时，此模式可以显
著提高可读性和效率。

• Internet：此配置文件组合颜色饱和度、
动态对比度和清晰度增强，可以使照片
和其他图像的色彩更鲜明更透澈 – 无人
工效果，无褪色。

• Game（游戏）：开启增速传动电路以达

到最佳响应时间，减少屏幕上快速移动

物体的锯齿边缘，增强明暗图案的对比

度，此配置文件为游戏玩家提供最佳游

戏体验。
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3. 图像优化

3.3 Philips SmartControl Lite

Phillips 提供的 SmartControl Lite 新软件可以通
过简单易用的图形界面控制显示器。这个用
户友好的软件可以指导您微调分辨率、颜色
校准、时钟 / 相位调整、RGB 白点调整等，
不再需要复杂的调整。

此软件的核心算法采用最新技术，可加快处
理和响应速度。它基于 Windows 7 标准的引
人注意的动画图标，一定会在您使用 Philips 
显示器时带来美好的体验 !

 安装

• 按照说明进行操作和完成安装。
• 安装完毕后即可启动。
• 以后启动时，可以单击桌面或工具栏上的

快捷方式。

首次启动 Wizard（向导）
• 第一次安装完 SmartControl Lite 后，自动

进入初次启动Wizard（向导）。
• 此向导指导您逐步调整显示器性能。
• 以后，您可以进入Plug-in（插件）菜单启

动向导。
• 不使用向导时，您可以通过Standard（标

准）窗格调整更多选项。
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3. 图像优化

 使用标准窗格：

Adjust（调整）菜单：
• 您可以利用Adjust（调整）菜单来调

整Brightness（亮度）、Contrast（对比
度）、Focus（聚焦）、Position（位置）
和Resolution（分辨率）。

• 您可以按照指导说明进行调整。
• Cancel（取消）提示用户是否取消安装。
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Color（颜色）菜单：
• 您可以利用 Color（颜色）菜单调整 

RGB、Black Level（黑色级别）、White 
Point（白点）、Color Calibration（颜色

校准）、以及 SmartImage Lite（请参见 
SmartImage Lite 一节）。

• 您可以按照指导说明进行调整。
• 根据输入，参见下表中的子菜单项目。
• Color Calibration（颜色校准）示例

1.	 “Show Me”（演示）启动颜色校准教程。
2.	 Start（开始） - 启动 6 步颜色校准过程。
3.	 Quick View（快速查看）加载之前 / 之后的

图像。
4.	 如要返回 Color（颜色）主窗格，可以单

击 Cancel（取消）按钮。
5.	 启用颜色校准 - 在默认情况下开启。若不

选中，则不允许执行颜色校准，开始和快
速查看按钮变暗。

6.	 校准屏幕上必须显示专利信息。
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3. 图像优化

• 显示当前首选项设置。
• 选中复选框时启用此功能。复选框相当于

一个切换开关。
• 在默认情况下，选中（开启）桌面上

的 Enable Context Menu（启用上下文菜

单）。Enable Context Menu（启用上下

文菜单）在桌面右键上下文菜单中显

示 SmartControl Lite 的 Select Preset（选

择预设值）和 Tune Display（调整显示）

的选项。禁用从右键上下文菜单中删除 
SmartControl Lite。

• 在默认情况下，选中 On（开启）Enable 
Task Tray（启用任务托盘）图标。Enable 
context menu（启用上下文菜单）显示 
SmartControl Lite 的任务托盘菜单。右键
单击任务托盘图标时，显示Help（帮助）、

Technical Support（技术支持）的菜单选项、

Check for Upgrade（检查更新）、About（关

于） 和 Exit（退出）。当禁用 Enable task 
tray menu（启用任务托盘菜单）时，任务

托盘图标将只显示 Exit（退出）。

• 在默认情况下，选中 On（开启）Run 
at Startup（启动时运行）。当禁用时，

SmartControl Lite 在启动时不运行，也不
在任务托盘中。启动 SmartControl Lite 的
唯一方式是从桌面快捷方式或从程序文
件。不选中此框（禁用）时，将不加载设
置为在启动时运行的预设值。

• Enable transparency mode（启用透明模式）
(Windows 7/Vista/XP）。默认值是 0% 不透
明。

第一个颜色校准屏幕：

• 在显示第二个颜色屏幕之前，Previous（上

一个）按钮被禁用。

• Next（下一个）进入后面的目标（6 个目

标）。
• Final next（最后下一个）进入 File>Presets

（文件 > 预设值）窗格。

• Cancel（取消）关闭用户界面，并返回插

件页。

SmartImage Lite
允许用户根据内容更改设置以得到更好的显
示设置。

当设置为 Entertainment（娱乐）时，启用 
SmartContrast 和 SmartResponse。

Options>Preferences（选项>首选项）- 仅
当从Options（选项）下拉菜单中选择 
Preferences（首选项）时可用。在不支持的显
示器（支持 DDC/CI）上，只有 Help（帮助）
和 Options（选项） 标签可用。
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3. 图像优化

Options>Input（选项 > 输入） - 仅当从
Options（选项） 下拉菜单中选择 Input（输入） 
时可用。在不支持的显示器（支持 DDC/CI）
上，只有 Help（帮助）和 Options（选项）标
签可用。所有其他 SmartControl Lite 标签都不
可用。

• 显示 Source（输入源）使用说明窗格和当
前输入源设置。

• 在单个输入显示上，不显示此窗格。

Options>Audio（选项 > 音频） - 仅当从
Options（选项）下拉菜单中选择Audio（音频） 
时可用。
在不支持的显示器（支持 DDC/CI）上，只有
Help（帮助）和 Option（选项）标签可用。
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3. 图像优化

Help>User Manual（帮助 > 用户手册） - 仅当
从 Help （帮助）下拉菜单中选择 User Manual 
（用户手册）时可用。在不支持的显示器 
（支持 DDC/CI）上，只有 Help（帮助）和 
Options（选项）标签可用。

Help>Version（帮助 >版本）- 仅当从 Help（帮
助）下拉菜单中选择 Version（版本）时可用。
在不支持的显示器（支持 DDC/CI）上，只有 
Help（帮助）和 Options（选项）标签可用。

上下文关联菜单
Context Sensitive Menu（上下文关联菜单）
在默认情况下被启用。如果在 Options> 
Preferences（选项 > 首选项）窗格中选中了
Enable Context Menu（启用上下文菜单），将
显示该菜单。

上下文菜单有 4 个项目：
• SmartControl Lite - 当选择时，显示 About

（关于）屏幕。

• Select Preset（选择预设值） - 提供已保存

的预设值的层级菜单，这些预设值可以立
即使用。复选标记表示当前选择的预设
值。此外，还可以从下拉菜单中调用工厂
预设值。

• Tune Display（调整显示） - 打开 
SmartControl Lite 控制面板。

• SmartImage Lite – 检查当前设置：Standard
（标准）、Internet、Game（游戏）。
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3. 图像优化

任务托盘菜单启用
右键单击任务托盘中的 SmartControl Lite 图标
时，显示任务托盘菜单。单击左键时启动应
用程序。

任务托盘有 5 个项目：
• Help（帮助） - 访问 User Manual（用户手

册） 文件：使用默认的浏览器窗口打开 
User Manual（用户手册） 文件。

• Technical Support（技术支持） - 显示技术
支持页面。

• Check for Update（检查更新） - 使用户登
录到 PDI 并检查是否有最新的版本。

• About（关于） - 显示详细的参考信息：
产品版本、发行信息、以及产品名称。

• Exit（退出） – 关闭 SmartControl Lite。

如要再次运行 SmartControl Lite，或者从
Program（程序） 菜单中选择 SmartControl 
Lite，或者双击 PC 桌面图标，或者重新启动
系统。

任务托盘菜单禁用
当在首选项文件夹中禁用任务托盘时，只
显示 EXIT（退出）选项。如要彻底从任
务托盘中删除 SmartControl Lite，可以在
Options>Preferences（选项 > 首选项）中禁用
Run at Startup（启动时运行）。
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4. 技术规格

4. 技术规格

273E3L/273E3LH

图片/显示

LCD面板类型 TFT-LCD
背光 WLED 273E3L/273E3LH
面板尺寸 27" (68.6 cm)
宽高比 16：9
像素点距 0.31 x 0.31 mm
亮度 300 cd/m² 
SmartContrast 20,000,000：1
对比度（典型） 1200：1
响应时间（典型） 5 ms (273E3L), 1 ms (273E3LH)
最佳分辨率 1920x1080 @ 60Hz
视角 170°(H) / 160°(V) @C/R>10
图片增强 SmartImage Lite
显示颜色数 1670 万
垂直刷新率 56Hz -76Hz
水平频率 30kHz - 83kHz
sRGB 是

连接性

信号输入 DVI-D（数字，HDCP），VGA（模拟）

输入信号 分离同步，绿色同步

方便性

用户便利性

OSD语言 英语、法语、德语、意大利语、俄语、西班牙语、简体中文、
葡萄牙语、土耳其语

其他便利性 Kensington 锁
即插即用兼容性 DDC/CI，sRGB，Windows 7/Vista/XP，Mac OSX，Linux
底座

倾斜 -5/+20 
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4. 技术规格

电源 
工作模式 27W（典型）

能耗 
（EnergyStar 5.0 测试方法）

交流输入电压 
100VAC +/-5VAC, 
50Hz +/-5Hz

交流输入电压 
115VAC +/-5VAC, 
50Hz +/-5Hz

交流输入电压 
230VAC +/-5VAC, 
50Hz +/ -5Hz

正常运行（典型） 19.6W 19.5W 19.6W
睡眠 0.5W 0.5W 0.5W
不亮 0.5W 0.5W 0.5W
散热* 交流输入电压 

100VAC +/-5VAC, 
50Hz +/ -5Hz

交流输入电压 
115VAC +/-5VAC, 
50Hz +/ -5Hz

交流输入电压 
230VAC +/-5VAC, 
50Hz +/ -5Hz

正常运行 66.89BTU/hr 66.55BTU/hr 66.89BTU/hr 
睡眠 1.71BTU/hr 1.71BTU/hr 1.71BTU/hr
不亮 1.71BTU/hr 1.71BTU/hr 1.71BTU/hr
电源 LED 指示灯 工作模式：白色，待机/睡眠：白色（闪烁）

电源 内置，100-240VAC, 50-60Hz

273E3LH

电源 
工作模式 <27.3W（典型）

<32.3W（最大）

能耗 
（EnergyStar 5.0 测试方法）

交流输入电压 
100VAC +/-5VAC, 
50Hz +/-5Hz

交流输入电压 
115VAC +/-5VAC, 
50Hz +/-5Hz

交流输入电压 
230VAC +/-5VAC, 
50Hz +/ -5Hz

正常运行（典型） 20.43W 20.35W 20.40W
睡眠 0.5W 0.5W 0.5W
不亮 0.3W 0.3W 0.3W
散热* 交流输入电压 

100VAC +/-5VAC, 
50Hz +/ -5Hz

交流输入电压 
115VAC +/-5VAC, 
50Hz +/ -5Hz

交流输入电压 
230VAC +/-5VAC, 
50Hz +/ -5Hz

正常运行 69.73 BTU/hr 69.45 BTU/hr 69.62 BTU/hr
睡眠 1.71 BTU/hr 1.71 BTU/hr 1.71 BTU/hr
不亮 1.02 BTU/hr 1.02 BTU/hr 1.02 BTU/hr
电源 LED 指示灯 工作模式：白色，待机/睡眠：白色（闪烁）

电源 内置，100-240VAC, 50-60Hz
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4. 技术规格

外形尺寸

产品（含底座）(WxHxD） 642x440x227mm

产品（不含底座）
(WxHxD）

642x391x64mm

包装箱尺寸（ WxHxD） 700x138x525mm

重量

产品（含底座） 8.2kg

产品（不含底座） 6.5kg

产品（含包装） 8.82kg

运行条件

温度范围（运行） 0˚C 到 40˚C

温度范围（非运行） -20˚C 到 60˚C

相对湿度 20% 到 80%

海拔高度
运行：+ 12,000 英尺（3,658 m）

不运行：+ 40,000 英尺（12,192 m）

MTBF 30,000 小时

环境

ROHS 是

EPEAT Silver（www.epeat.net）

包装 100% 可回收

特定物质 用户可接触部件不含 PVC/BFR Free3（线缆和适配器除外）

符合性和标准

管制认证
CE Mark、FCC Class B、SEMKO、TÜGS、TÜrgo、UL/cUL、
Energy star 5.0、TCO 5.1

机壳

颜色 黑色/黑色 /

表面处理 纹理/纹理

 注

1. EPEAT Gold 和 Sliver 仅在 Philips 注册了产品的地区有效。有关您所在国家地区的注册状况 ,
请访问 www.epeat.net。

2. 此数据如有变更，恕不另行通知。访问 www.philips.com/support 下载最新版本的宣传页。

3. 此显示器的所有用户可接触部件（线缆和适配器除外）均不含有溴化阻燃剂和聚氯乙烯（不
含 PVC/BFR）。这些部件中阻燃剂形式的有机溴化合物的含量不得达到或超过 0.09%（溴最
多 900ppm），这些部件中聚氯乙烯或聚氯乙烯同等物质形式的有机溴化合物的含量不得达
到或超过 0.1%（氯最多 1000ppm）。
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4. 技术规格

4.1 分辨率和预设模式

 最大分辨率

对于 273E3L/273E3LH
1920 x 1080 @ 60 Hz（模拟输入）
1920 x 1080 @ 60 Hz（数字输入）

 推荐分辨率

对于 273E3L/273E3LH
1920 x 1080 @ 60 Hz（数字输入）

水平频率
（kHz）

分辨率 垂直频率  
(Hz）

31.47 720x400 70.09
31.47 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
63.89 1280x1024 60.02
79.98 1280x1024 75.03
55.94 1440x900 59.89
70.64 1440x900 74.98
65.29 1680x1050 59.95
67.50 1920x1080 60.00
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5. 自动省电

5. 自动省电

5.1 自动省电

如果 PC 中安装了 VESA DPM 兼容显示卡或者软
件，显示器可以在不使用时自动降低功耗。 如
果检测到来自键盘、鼠标或其它输入设备的输
入，显示器将自动“唤醒”。 下表介绍此自动

省电功能的功耗和信号时序：

273E3L

电源管理定义
VESA 模式 视频 水平 

同步
垂直
同步

使用的功率 LED 颜色 

工作 开启 是 是 < 27 W（典型） 白色

睡眠 
（待机）

关闭 否 否 < 0.5 W 白色 
（闪烁）

关闭 关闭 - - < 0.5 W 关闭

273E3LH

电源管理定义
VESA 模式 视频 水平 

同步
垂直
同步

使用的功率 LED 颜色 

工作 开启 是 是 < 27.3 W（典型）
< 32.3 W（最大）

白色

睡眠 
（待机）

关闭 否 否 < 0.5 W 白色 
（闪烁）

关闭 关闭 - - < 0.3 W 关闭

下面的设置用于测量此显示器的功耗。

固有分辨率：1920 x 1080
对比度：50%
亮度：300 尼特
色温：6500k 全白图案

 注
此数据如有变更，恕不另行通知。



23

6. 有关规定

6. 有关规定

Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated and 
compliance with European community’s stringent 
RoHs directive mandating restrictions on 
hazardous substances in electrical and electronic 
equipment have been adhered to in order to 
make Philips monitors safe to use throughout its 

life cycle.
Congratulations! 
This display is designed for both you and the 
planet!

The display you have just purchased 
carries the TCO Certified label. This 
ensures that your display is designed, 
manufactured and tested according 
to some of the strictest quality and 
environmental requirements in 

the world. This makes for a high performance 
product, designed with the user in focus that also 
minimizes the impact on the climate and our 
natural environment.

TCO Certified is a third party verified program, 
where every product model is tested by an 
accredited impartial test laboratory. TCO 
Certified represents one of the toughest 
certifications for displays worldwide.

Some of the Usability features of the TCO 
Certified for displays! 

• Visual ergonomics for good image quality 
is tested to ensure top performance and 
reduce sight and strain problems. Important 
parameters are luminance, contrast, 
resolution, black level, gamma curve, colour 
and luminance uniformity and colour 
rendering

• Products are tested according to rigorous 
safety standards at impartial laboratories 

• Electric and magnetic fields emissions as low 
as normal household background levels

• Low acoustic noise emissions (when 
applicable)

Some of the Environmental features of the TCO 
Certified for displays:

• The brand owner demonstrates corporate 
social responsibility and has a certified 
environmental management system (EMAS or 
ISO 14001) 

• Very low energy consumption both in on- 
and standby mode minimize climate impact 

• Restrictions on chlorinated and brominated 
flame retardants, plasticizers, plastics and heavy 
metals such as cadmium, mercury and lead 
(RoHS compliance)

• Both product and product packaging is 
prepared for recycling 

• The brand owner offers take-back options 

The requirements can be downloaded from our 
web site. The requirements included in this label 
have been developed by TCO Development in 
co-operation with scientists, experts, users as well 
as manufacturers all over the world. Since the end 
of the 1980s TCO has been involved in influencing 
the development of IT equipment in a more user-
friendly direction. Our labeling system started with 
displays in 1992 and is now requested by users 
and IT-manufacturers all over the world. About 
50% of all displays worldwide are TCO certified. 
 
For more information, please visit  
www.tcodevelopment.com 

 TCOFF1058 TCO Document, Ver. 2.1

Technology for you and the planet
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6. 有关规定

•	 2005/32/EC (EuP Directive, EC No. 		
	 1275/2008 mplementing Directive for 	
	 Standby and Off mode power consumption) 	
	 and is produced by a manufacturing 		
	 organization on ISO9000 level. 
•	 The product also comply with the following 	
	 standards 
•	 ISO9241-307:2008 (Ergonomic requirement, 	
	 Analysis and compliance test methods for 	
	 electronic visual displays)  
•	 GS EK1-2000:2009 (GS mark requirement)  
•	 prEN50279:1998 (Low Frequency Electric 	
	 and Magnetic fields for Visual Display) 
•	 MPR-II (MPR:1990:8/1990:10 Low Frequency 	
	 Electric and Magnetic fields) 
•	 TCO Displays 5.0 (Requirement for
	 Environment Labeling of Ergonomics, 	
	 Energy,  Ecology and Emission, TCO: Swedish 	
	 Confederation of Professional Employees) 	
	 for TCO versions 

Energy Star Declaration 
(www.energystar.gov)

“The EPEAT (Electronic Product 
Environmental Assessment Tool) 
program evaluates computer 
desktops, laptops, and monitors 
based on 51 environmental criteria 

developed through an extensive stakeholder 
consensus process supported by US EPA.
EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and select 
desktop computers, notebooks and monitors 
based on their environmental attributes. EPEAT 
also provides a clear and consistent set of 
performance criteria for the design of products, 
and provides an opportunity for manufacturers to 
secure market recognition for efforts to reduce 
the environmental impact of its products.”
Benefits of EPEAT
Reduce use of primary materials
Reduce use of toxic materials
Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity
This product is in conformity with the following 
standards 
•	 EN60950-1:2006 (Safety requirement of 	
	 Information Technology Equipment) 
•	 EN55022:2006 (Radio Disturbance 		
	 requirement of Information Technology 	
	 Equipment) 
•	 EN55024:1998+A1:2001+A2:2003 		
	 (Immunity requirement of Information 	
	  Technology Equipment) 
•	 EN61000-3-2:2006 (Limits for Harmonic 	
	 Current Emission) 
•	 EN61000-3-3:1995+A1:2001+A2:2005 	
	 (Limitation of Voltage Fluctuation and Flicker)
	 following provisions of directives applicable
•	 2006/95/EC (Low Voltage Directive) 
•	 2004/108/EC (EMC Directive)
 

EPEAT 
(www.epeat.net)

As an ENERGY STAR® Partner, 
we have determined that this 
product meets the ENERGY STAR® 
guidelines for energy efficiency.

	Note
We recommend you switch off the monitor 
when it is not in use for a long time.
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6. 有关规定

Federal Communications Commission (FCC) 
Notice (U.S. Only)

	 This equipment has been tested and found 	
	 to comply with the limits for a Class B digital 	
	 device, pursuant to Part 15 of the FCC 
	 Rules. These limits are designed to 		
	 provide reasonable protection against 	
	 harmful interference in a residential 		
	 installation. This equipment generates, uses 	
	 and can radiate radio frequency energy and, 	
	 if not installed and used in accordance with
	 the instructions, may cause harmful 		
	 interference to radio communications. 	
	 However, there is no guarantee that 	
	 interference will not occur in a particular 	
	 installation. If this equipment does cause 	
	 harmful interference to radio or television 	
	 reception, which can be determined by 	
	 turning the equipment off and on, the user 
	 is encouraged to try to correct the 		
	 interference by one or more of the following 	
	 measures:
•	 Reorient or relocate the receiving antenna. 
•	 Increase the separation between the 	
	 equipment and receiver. 
•	 Connect the equipment into an outlet on 	
	 a circuit different from that to which the 	
	 receiver is connected. 
•	 Consult the dealer or an experienced radio/	
	 TV technician for help.

	 Changes or modifications not expressly 	
	 approved by the party responsible for 	
	 compliance could void the user's authority 	
	 to operate the equipment.

Use only RF shielded cable that was supplied with 
the monitor when connecting this monitor to a 
computer device. 
To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to rain 
or excessive moisture. 
THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity
Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. 
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6. 有关规定

Commission Federale de la Communication(FCC 
Declaration)

	 Cet équipement a été testé et déclaré 	
	 conforme auxlimites des appareils 		
	 numériques de class B,aux termes de 	
	 l'article 15 Des règles de la FCC. Ces limites 	
	 sont conçues de façon à fourir une  
	 protection raisonnable contre les 		
	 interférences nuisibles dans le cadre 		
	 d'une installation résidentielle. 
	 CET appareil produit, utilise et peut émettre 	
	 des hyperfréquences qui, si l'appareil 	
	 n'est pas installé et utilisé selon les consignes 	
	 données, peuvent causer des interférences 	
	 nuisibles aux communications radio. 
	 Cependant, rien ne peut garantir l'absence 	
	 d'interférences dans le cadre d'une 		
	 installation particulière. Si cet appareil est la 	
	 cause d'interférences nuisibles pour la 	
	 réception des signaux de radio ou de 	
	 télévision, ce qui peut être décelé en fermant 	
	 l'équipement, puis en le remettant en 	
	 fonction, l'utilisateur pourrait essayer de 	
	 corriger la situation en prenant les mesures 	
	 suivantes:
•	 Réorienter ou déplacer l'antenne de 	
	 réception. 
•	 Augmenter la distance entre l'équipement et 	
	 le récepteur. 
•	 Brancher l'équipement sur un autre circuit 	
	 que celui utilisé par le récepteur. 
•	 Demander l'aide du marchand ou d'un 	
	 technicien chevronné en radio/télévision.

	 Toutes modifications n'ayant pas reçu 	
	 l'approbation des services compétents en 	
	 matière de conformité est susceptible 	
	 d'interdire à l'utilisateur l'usage du présent 	
	 équipement.

N'utiliser que des câbles RF armés pour les 
connections avec des ordinateurs ou 
périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA.
 
EN 55022 Compliance (Czech Republic Only)
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6. 有关规定

Notice

The equipment should draw power from a socket 
with an attached protection circuit (a three-
prong socket). All equipment that works together 
(computer, monitor, printer, and so on) should 
have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.

North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR DU 
STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
S Ø R G  V E D  P L A C E R I N G E N  F O R ,  A T 
NETLEDNINGENS STIK OG STIKKONTAKT ER 
NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARV ITTAESSA HELPOST I 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)
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6. 有关规定

China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.

 

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den 
in der "Verordnung über den Schutz vor Schäden 
durch Röntgenstrahlen" festgelegten Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften über 
die Bauart von Störstrahlern nach Anlage III ¤ 5 
Abs. 4 der Röntgenverordnung erfüllt sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 
1.	 Reparaturen nur durch Fachpersonal 	
	 durchgeführt werden. 
2.	 nur original-Ersatzteile verwendet werden. 
3.	 bei Ersatz der Bildröhre nur eine 		
	 bauartgleiche eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf dunklem 
Untergrund zu verwenden (schlechte Lesbarkeit 
und erhöhte Augenbelastung bei zu geringem 
Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel nach 
DIN 45 635 beträgt 70dB (A) oder weniger. 

ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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7. 客户服务与保修

7.1 飞利浦平面显示器像素残缺规定

飞利浦致力于提供最优质的产品。本公司运
用同行业最先进的制造程序，实行严格的质
量管理。不过，平板显示器使用的 TFT LCD
面板若有像素或子像素残缺，有时也是事所
难免。没有任何厂家能够担保所有的屏幕皆
无像素残缺，飞利浦却保证任何显示器，如
果超过不可接受的残缺量，必将得到担保条
件下的维修或替换。此处须知描述不同种类
的像素残缺，规定每一种类可以接受的残缺
水准。为了符合所担保的维修或替换，TFT 
LCD面板上的像素残缺量必须超过这些可接
受的水准。例如，显示器上不足 0.0004% 的
子像素可能存在缺陷。此外，鉴于有些像素
残缺种类或组合比其它更引人注意，飞利浦
对此种类确定更高的质量标准。本规定全球
范围有效。

分像素分像素分像素

像素

像素和分像素
一个像素，或称图像元素，由三个属于红绿
蓝主颜色的分像素组成。许多像素在一起形
成一个图像。像素里的所有分像素全被照亮
时，三个带颜色的分像素一起以一个白色像
素出现。当他们全部变暗时，三个带颜色的
分像素一起以一个黑色像素出现。其它类的
明暗分像素组合则以其它颜色的单个像素出
现。

像素残缺种类
像素和分像素残缺以不同形式出现在屏幕上。 
有两类像素残缺，每一类内有多种分像素残
缺。

亮点缺陷
亮点缺陷是一直点亮的像素或子像素。也就
是说，亮点是当显示器屏幕上显示暗图案时
一直发亮的子像素。亮点缺陷有如下类型：

一个发亮的红绿蓝分像素

二个相邻发亮的分像素：
 - 红+蓝=紫
 - 红+绿=黄
 - 绿+蓝=氰（浅蓝）

三个相邻发亮分像素（一个白色像素）
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 注
红色或蓝色亮点的亮度超过周围点 50% 以上；
绿色亮点的亮度超过周围点 30%。

暗点缺陷
暗点缺陷是一直不亮的像素或子像素。 也就
是说，黑点是当显示器屏幕上显示亮图案时
一直发暗的子像素。 黑点缺陷有如下类型：

紧凑像素残缺
鉴于靠在一起的同类像素和分像素残缺更引
人注意，飞利浦同样制定紧凑像素残缺的容
许规格。

像素残缺容许规格
为了符合保修期内由于像素残缺而需要的维
修或替换，飞利浦平板显示器的 TFT LCD 面
板必须有超过下表所列容许规格的像素和子
像素缺陷。

亮点缺陷 可接受的程度

1个亮的子像素 3
2个相邻的亮的子像素 1
3个相邻的亮的子像素（1个白色像素） 0
两个缺陷亮点之间的距离* >15mm
所有类型的缺陷亮点总数 3

黑点缺陷 可接受的程度

1个黑的子像素 5 或以下

2 个相邻的黑的子像素 2 或以下

3 个相邻的黑的子像素 0
两个缺陷黑点之间的距离* >15mm
所有类型的缺陷黑点总数 5 或以下

缺陷点总数 可接受的程度

所有类型的缺陷亮点或黑点的总数 5 或以下

 注

1. 1 或 2 个相邻缺陷子像素 = 1 个缺陷点

2. 此显示器符合 ISO 9241-307 标准。（ ISO 9241-307： 人机工程学要求，分析和电子视觉显
示的符合性检测方法）
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7.2 客户服务与保修

有关您所在地区的保修范围信息和更多支持要求，请访问 www.philips.com/support 网站了解详
细信息。您也可以拨打下面列出的您当地的飞利浦客户服务中心电话。

西欧地区的联系信息：

国家/地区 ASC 客户服务电话 费用

Germany Siemens I&S +49 01803 386 853 € 0,09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff

Ireland Invec Scotland +353 01 601 1161 Local call tariff

Spain Eatsa Spain +34 902 888 785 € 0,10

Finland A-novo +358 09 2290 1908 Local call tariff

France A-novo +33 082161 1658 € 0,09

Greece Allman Hellas +30 00800 3122 1223 Free of charge

Italy A-novo +39 840 320 041 € 0,08

Netherlands E Care +31 0900 0400 063 € 0,10

Denmark A-novo +45 3525 8761 Local call tariff

Norway A-novo +47 2270 8250 Local call tariff

Sweden A-novo +46 08 632 0016 Local call tariff

Poland Zolter +48 0223491505 Local call tariff

Austria Siemens I&S +43 0810 000206 € 0,07

Belgium E Care +32 078 250851 € 0,06

Luxembourg E Care +352 26 84 30 00 Local call tariff

Portugal Eatsa Spain +351 2 1359 1440 Local call tariff

Switzerland A-novo +41 02 2310 2116 Local call tariff
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中东欧地区的联系信息：

国家/地区 呼叫中心 ASC 客户服务电话

BELARUS NA IBA +375 17 217 3386

BULGARIA NA LAN Service +359 2 960 2360

CROATIA NA Renoprom +385 1 333 0974

ESTONIA NA FUJITSU +372 6519900

LATVIA NA “ServiceNet LV” Ltd. +371 7460399

LITHUANIA NA UAB "Servicenet" +370 7400088

ROMANIA NA Blue Ridge Intl. +40 21 2101969

SERBIA & 
MONTENEGRO

NA Kim Tec d.o.o. +381 11 20 70 684

SLOVENIA NA PC H.and +386 1 530 08 24

UKRAINE
NA Comel +380 562320045 

NA Topaz-Service Company +38 044 245 73 31

Russia
NA CPS +7 (495) 645 6746 (for repair)

NA CEEE Partners +7 (495) 645 3010 (for sales)

Slovakia NA Datalan Service +421 2 49207155

Turkey NA Techpro +90 212 444 4 832 

Czech Rep. NA Asupport 800 100 697

Hungary
NA Serware +36 1 2426331 

NA Profi Service +36 1 814 8080

拉丁美洲地区的联系信息：

国家/地区 呼叫中心 客户服务电话

Brazil
Vermont 

0800-7254101

Argentina 0800 3330 856

中国联系信息：

中国
客户服务电话： 4008 800 008

北美联系信息：

国家/地区 呼叫中心 ASC 客户服务电话

U.S.A. TOS Teleplan (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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APMEA 地区联系信息：

国家/地区 呼叫中心 ASC 客户服务电话

Australia NA AGOS NETWORK PTY LTD 1300 360 386

New Zealand NA Visual Group Ltd. 0800 657447

Hong Kong / 
Macau

NA Smart Pixels Technology Ltd.
Hong Kong: Tel: +852 2619 9639 
Macau:Tel: (853)-0800-987

India NA REDINGTON INDIA LTD
Tel: 1 800 425 6396 
SMS: PHILIPS to 56677 

Indonesia NA
PT. Gadingsari elektronika 
Prima

Tel: 62 21 75909053, 75909056, 
7511530 

South Korea NA PCS One Korea Ltd. 080-600-6600

Malaysia NA
After Market Solutions (CE) 
Sdn Bhd

603 7953 3370

Pakistan NA Philips Consumer Service (9221) 2737411-16

Singapore NA
Philips Electronics Singapore 
Pte Ltd (Philips Consumer 
Care Center)

(65) 6882 3999

Taiwan
PCCW 
Teleservices 
Taiwan 

FETEC.CO 0800-231-099

Thailand NA
Axis Computer System Co., 
Ltd.

(662) 934-5498

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888 

UNITED ARAB 
EMIRATES

NA
AL SHAHD COMPUTER 
L.L.C

00971 4 2276525

Israel NA Eastronics LTD 1-800-567000

Vietnam NA
FPT Service Informatic 
Company Ltd.

+84 8 38248007 Ho Chi Minh City 
+84 5113.562666 Danang City 
+84 5113.562666 Can tho Province

Philippines NA Glee Electronics, Inc.
(02) 633-4533 to 34, 
(02) 637-6559 to 60

Sri Lanka NA
no distributor and/or service 
provider currently

Bangladesh NA
Distributor: Computer Source 
Ltd (warranty buy-out)

880-2-9141747, 9127592 
880-2-8128848 / 52

Nepal NA
Distributor: Syakar Co. Ltd 
(warranty buy-out)

977-1-4222395 

Cambodia NA
Distributor: Neat Technology 
Pte Ltd (Singapore) (warranty 
buy-out)

855-023-999992
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8. 故障排除和常见问题解答

AUTO（自动）按钮不起作用
• 自动功能仅适用于 VGA-模拟模式。如果

对结果不满意，您可以通过 OSD 菜单进
行手动调整。

 注
自动功能不适用于 DVI-数字模式，因为该
模式不需要自动调整。

冒烟或出现火星
• 切勿执行任何故障排除步骤
• 为安全起见，立即从主电源上拔掉显示器

电源线
• 立即与 Philips 客户服务代表联系。

 图像问题

图像不居中
• 使用 OSD 主控制中的“Auto”（自动）

功能调整图像位置。
• 使用 OSD 主控制中Setup（设置）的

Phase/Clock（相位/时钟）调整图像位置。 
这仅在 VGA 模式下起作用。

屏幕上的图像震动
• 检查信号线是否正确牢固地连接到图形板

或 PC。

有垂直闪烁现象

• 使用 OSD 主控制中的“Auto”（自动）
功能调整图像位置。

• 使用 OSD 主控制中 Setup（设置）的
Phase/Clock（相位/时钟）消除竖条。 这
仅在 VGA 模式下起作用。

8. 故障排除和常见问题解答

8.1 故障检修

本页介绍用户可以解决的问题。如果在尝试
这些解决办法后问题仍然存在，请与 Philips 
客户服务代表联系。

 常见问题

无图片（电源 LED 不亮）
• 确保电源线两端分别插入电源插座和显示

器背面的插口。
• 首先，确保显示器正面的电源按钮处于 

OFF（关闭）位置，然后将其按至 ON 
（开启）位置。

无图片（电源 LED 显示白色）
• 确保计算机处于开机状态。
• 确保信号线正确连接到计算机。
• 确保显示器线缆接头没有弯曲的插针。 

若有，请修理或更换线缆。
• 可能激活了节能功能

屏幕上显示

• 确保显示器线缆正确连接到计算机。 
（另请参见快速入门指南）。

• 检查显示器线缆是否有弯曲的插针。
• 确保计算机处于开机状态。
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有水平闪烁现象

• 使用 OSD 主控制中的“Auto”（自动）
功能调整图像位置。

• 使用 OSD 主控制中 Setup（设置）的
Phase/Clock（相位/时钟）消除竖条。这仅
在 VGA 模式下起作用。

图像模糊不清或太暗
• 使用 OSD 调整对比度和亮度。

关闭电源后仍有图像残留或重影现象。
• 长时间不间断显示静止或静态图像可能会

在屏幕上造成“烙印”，也称“残像”
或“余像”。“烙印”、“残像”或“余
像”是LCD面板技术的一种常见现象。大
多数情况下，在关闭电源后，图像残留或
重影会随着时间的推移而逐渐消失。

• 显示器无人看管时务必启动移动的屏幕保
护程序。

• 如果液晶显示器将显示静止不变的内容，
请务必启用屏幕定期刷新应用程序。

• 严重的“烙印”、“残像”或“余像”不
会消失，不能修复。上面提到的损坏不在
保修范围内。

图像变形。文字模糊。
• 将 PC 的显示分辨率设成显示器屏幕的固

有分辨率。

屏幕上出现绿色点、红色点、蓝色点、黑点
或白点
• 坏点是当今使用的液晶技术的正常特性，

请参见像素策略以了解详情。

“电源开启”指示灯太亮，会干扰我
• 您可以使用 OSD 主控制中设置的电源 

LED来调整“电源开启”指示灯。

如需进一步帮助，请参见消费者信息中心列
表并联系 Philips 客户服务代表。
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8.2 SmartControl Lite 常见问题解答

问题 1： 当我将显示器从一个 PC 切换到另一
个 PC 时，SmartControl Lite 变得无
法使用，怎么办？

回答： 重新启动 PC，检查 SmartControl Lite 
是否工作正常。否则，您需要删除然
后重新安装 SmartControl Lite 以确保
安装正确的驱动程序。

问题 2： SmartControl Lite 以前工作正常，但
现在不工作，怎么办？

回答： 如果执行了下列操作，可能需要重新
安装显示器驱动程序。

• 切换至另一个视频图形适配器
• 更新视频驱动程序
• 与操作系统有关的活动，如 service 

pack 或补丁程序
• 运行 Windows Update 和更新显示器
和 / 或视频驱动程序

• 在显示器关闭或断开的情况下启动了 
Windows。
为找到原因，请右键单击 My 
Computer（我的电脑） ，然后单击
Properties（属性）-> Hardware（硬
件） -> Device Manager（设备管理
器）。
如果看到显示器下面出现“Plug and 
Play Monitor（即插即用显示器）”，
则需要重新安装。 删除 SmartControl 
Lite，然后重新安装它。

问题 3： 安装完 SmartControl Lite 后，单击 
SmartControl Lite 标签时，不显示任
何信息或者显示失败信息，为什么？

回答： 可能是图形适配器与 SmartControl 
Lite 不兼容。如果图形适配器是上面
提到的一种品牌，请尝试从相应公司
的网站上下载最新的图形适配器驱动
程序。
安装驱动程序。删除 SmartControl 
Lite，然后重新安装一次。

如果仍不能工作，则图形适配器不
受支持。请访问 Philips 网站，检查是
否有更新的 SmartControl Lite 驱动程
序。

问题 4： 当我单击 Product Imformation（产品
信息）时，只显示部分信息，为什
么？

回答： 可能是图形卡适配器驱动程序不是最
新版本，因而不完全支持 DDC/CI 接
口。 请尝试从相应公司网站下载最
新的图形适配器驱动程序。安装驱动
程序。
删除 SmartControl Lite，然后重新安
装一次。

问题 5： 我忘记了 Theft Deterrence（防盗功
能）的 PIN。怎么办？

回答： 为了确定显示器的所有权，飞利浦服
务中心有权要求提供合法身份和授
权。
请注意，防盗功能作为免费便利选项
提供。妥善管理 PIN 码是设置了该代
码的各个用户或组织的责任。
万一忘记了 PIN 码，Philips 服务中心
可以在验证所有者身份后进行重设，
但需收取标称的费用。请注意，此活
动不在标准保修条款的范围之内。
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8.3 一般常见问题解答

问题 1： 安装显示器时，如果屏幕上显示
“Cannot display this video mode”（无
法显示此视频模式），怎么办？

回答： 建议此显示器使用的分辨率：1920 x 
1080 @60Hz。

• 拔掉所有线缆，然后将 PC 连接到您
原来使用的显示器。

• 在 Windows Start（开始） 菜单中，
选择 Settings/Control Panel（设置 / 控
制面板）。 在 Control Panel（控制面
板） 窗口中，选择 Display（显示） 
图标。 在 Display（显示） 控制面板
中，选择“Setting”（设置）选项
卡。 在 Setting（设置）选项卡下的
“desktop area”（桌面区域）框中，
将滑块移到 1920 x 1080 像素。

• 打开“Advanced Properties”（高级
属性），将刷新率设为 60Hz，然后
单击 OK（确定）。

• 重新启动计算机，然后重新执行步骤 
2 和 3 以确认 PC 设置在 1920 x 1080 
@60Hz。

• 关闭计算机，断开原来的显示器，重
新连接 Philips LCD 显示器。

• 打开显示器电源，然后打开 PC 电
源。

问题 2： 建议 LCD 显示器使用的刷新率是多
少？

回答： 建议的 LCD 显示器刷新率是 60Hz，
若屏幕上出现任何干扰，最高可将其
设成 75Hz 以检查能否消除干扰。

问题 3： 光盘上的 .inf 和 .icm 文件有什么用？ 
如何安装驱动程序（.inf 和 .icm）？

回答： 它们是显示器的驱动程序文件。按照
用户手册中的说明安装驱动程序。第
一次安装显示器时，计算机可能会需
要显示器驱动程序（.inf 和 .icm 文件）
或驱动程序磁盘。按照说明插入产品
包装中包含的光盘。 显示器驱动程
序（.inf 和 .icm 文件）将会自动安装。

问题 4： 如何调整分辨率？

回答： 您的视频卡 / 图形驱动程序和显示器
共同决定了可用的分辨率。您可以
在 Windows® 控制面板的“Display 
properties”（显示属性）中选择所
需的分辨率。

问题 5： 调整显示器时不知道如何操作怎么
办？

回答： 只需按“OK”（确定）按钮，然后
选择“Reset”（重置）即可全部恢
复至原始出厂设置。

问题 6 LCD 屏幕是否抗刮擦 ?

回答： 一般而言，建议您不要用力撞击面板
表面，并且应防止锐利或坚硬物品接
触面板表面。操作显示器时，请勿施
力于面板表面。否则，可能会影响保
修。

问题 7： 如何清洁 LCD 表面？

回答： 使用干净的软布进行正常清洁。细致
清洁时，请使用异丙醇。请勿使用普
通酒精、乙醇、丙酮、己烷等其他溶
剂。
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问题 8 我可以更改显示器的颜色设置吗？

回答： 可以，您可以通过 OSD 控制来更改
颜色设置，具体步骤如下：

• 按“OK”（确定）显示 OSD（屏幕
显示）菜单

• 按“Down Arrow”（向下箭头）选
择“Color”（颜色）选项，然后按
“OK”（确定）进入颜色设置，有
如下三个设置。
1.	Color Temperature（色温）：包
括 6 个设置，分别是 5000K、
6500K、7500K、8200K、9300K 
和 11500K。 设置在 5000K 范围
内时，面板上显示“warm”（暖
色），呈现红白色调；色温为 
11500K 时显示“cool”（冷色），
呈现蓝白色色调。

2.	sRGB：这是确保在不同设备（如
数码相机、显示器、打印机、扫描
仪等）之间正确交换颜色的一种标
准。

3.	User Define（用户定义） ：用户可
以调整红色、绿色和蓝色，从而选
择自己喜欢的颜色设置。

 注：
当物体被加热时所放射的光的色彩测量
值。该测量值以绝对温标来表述（开尔
文度数）。较低的开氏温度（如 2004K）
是红色；较高的温度（如 9300K）是蓝
色。中性温度是白色，6504K。

问题 9：我可以将我的液晶显示器连接到 
PC、工作站或 Mac 吗？

回答： 可以。飞利浦的所有液晶显示器都与
标准的 PC、Mac 和工作站完全兼容。 
将此显示器连接到 Mac 系统时，您
需要使用一个线缆适配器。有关的详
细信息，请与您的飞利浦销售代表联
系。

问题 10 飞利浦液晶显示器可以即插即用吗？

回答： 可以，这些显示器在 Windows 7/
Vista/XP/NT 丄 Mac OSX 丄 Linux 下
支持即插即用功能。

问题 11 液晶显示器面板上的图像残留或重影
是指什么？

回答： 长时间不间断显示静止或静态图像可

能会在屏幕上造成“烙印”，也称“残

像”或“余像”。“烙印”、“残像”

或“余像”是显示器面板技术的一种

常见现象。大多数情况下，在关闭电

源后，图像残留或重影会随着时间的

推移而逐渐消失。 
显示器无人看管时务必启动移动的屏

幕保护程序。 
如果显示器将显示静止不变的内容，

请务必启用屏幕定期刷新应用程序。

 警告
严重的图像残留或重影现象将无法消
失，也无法修复。上面提到的损坏不在
保修范围内。

问题 12 为什么显示器显示的文字不够清晰，
显示的字符有锯齿现象？

回答： 此液晶显示器在其固有分辨率 1920 x 
1080 @60Hz 时工作效果最佳。为达
到最佳显示效果，请使用此分辨率。
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